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Preface 0

Bruker strives to supply you with instructional and accurate doc-
umentation. We encourage you to tell us how we are doing.
Please send us your suggestions for improvements, corrections,
or bug reports. If there is anything you particularly liked, tell us
as well. With your input and assistance, Bruker can continually
improve its products and documentation.

You can send your messages and correspondence via e-mail,
FAX, telephone, or mail. It is important to include the document
name, product name, version number, and page number in your
response. Here are the addresses and numbers to which you can
send your messages.

e-mail: rtw@bruker.com

FAX: 508-670-8851

Tel. 508-667-9580 ext. 137

mailing
address

Dr. Ralph T. Weber
EPR Division
Bruker Instruments, Inc.
19 Fortune Drive
Manning Park
Billerica, MA 01821 USA

Thank you for your help.
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Introduction 1

Purpose 1.1
The scope of this manual encompasses many purposes. The
objective is to guide you through a successful installation of 
program onto your computer. The second objective is to as
you in becoming proficient and productive with the progra
The last objective is to supply you with a complete reference
and description of the menus, commands, and messages.

WIN-EPR SimFonia 1.2
WIN-EPR SimFonia is a fast, easy to use EPR spectral simu
tion program that runs on a PC under Microsoft-Windows®. The
simulation algorithm is based upon perturbation theory. Bo
solution and powder spectra can be simulated. Simulated spect
can be saved in a WIN-EPR compatible format for sophistica
post-processing with WIN-EPR.
WIN-EPR SimFonia User’s Manual
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Features of WIN-EPR SimFonia 1.3

Program • Mouse driven simplicity: easy access pull down menus a
dialogue boxes.

• Hardcopy of spectra using any output device supported b
Microsoft Windows®.

• Comparison of experimental spectra with simulated spect

• Elementary data processing.

• Easy transfer of simulated spectra to WIN-EPR for sophi
cated post-processing.

• Choice of Gauss, MHz, or 10-4 cm-1 for parameter units.

• Simulation of both solution and powder spectra via an e
cient perturbation theory algorithm.
WIN-EPR SimFonia User’s Manual 1-2
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Solution
Simulations

• Spectra which are adequately described by the spin ham
nian,

H = g µB B0 S + a S.I + gn µN B0 I, [1-1]

can be simulated. (i.e. rapidly tumbling radicals in solution

• Choice between first order or third order perturbation theo
to simulate both weak and strong hyperfine splittings.

• Many-lined spectra can be quickly calculated because of
efficient FT (Fourier Transform) algorithm.

• Up to 20 inequivalent nuclei with a virtually unlimited num
ber of equivalent nuclei can be simulated without lar
amounts of memory because of the efficient FT algorithm.

• Lorentzian, Gaussian, and Voigt lineshapes can be simula

• Isotopic mixtures of nuclei are easily and quickly sim
lated.The Bruker ENDOR table with natural abundance, sp
and nuclear g value data is implemented with a user-frien
periodic table interface for convenient isotope data entry and
access.

• The effect of magnetic field modulation amplitude as well 
time constant can be quickly and accurately simulated. T
feature is very useful as an instructional aid for beginners.

• Both g and a values for first order spectra can be interactiv
entered by placing cursors at the appropriate locations in
experimental spectrum.

• mi dependent linewidths from incompletely averaged aniso-
tropic interactions can be simulated by a polynomial appro
mation. A least squares fitting routine to determine t
polynomial coefficients from experimental spectrum lin
widths greatly aids in these calculations.
WIN-EPR SimFonia User’s Manual 1-3
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Powder
Simulations

• Spectra which are adequately described by the spin ham
nian,

H =  µB B0.g.S + S.D.S + S.A.I  + I .P.I  + µN B0.gn.I , [1-2]

can be simulated. (i.e. samples consisting of many sma
crystals or a glass.)

• You can choose between first order or second order pertu
tion theory to simulate both weak and strong hyperfine split-
tings.

• No assumptions are made regarding the orientations of
principal axes of g, A, P, and gn. It is assumed that g and D
have coincident principal axes.

• Lorentzian, Gaussian, and Voigt lineshapes can be simula

• Up to 20 inequivalent nuclei with a large number of equiv
lent nuclei can be incorporated into the powder simulation

• Anisotropic linewidths can be simulated by entering the lin
widths along the principal axes of g.
WIN-EPR SimFonia User’s Manual 1-4
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Getting Started 2

Using this Manual 2.1

How to Find Things 2.1.1

Getting Started For those of you who need to install the program on your co
puter, this chapter is the place to begin.

Theory Both beginners and advanced users should read Chap
regarding the theory used in the simulation algorithms. Appro
mations are made and it is important to understand under w
conditions it is appropriate to use the approximations.

A SimFonia
Tutorial

Much of the program can be learned by exploring the ma
commands and menus. Chapter 4, a tutorial, offers a more struc-
tured approach to becoming proficient with the program.

Command
Reference

After you are comfortable with the program, Chapter 5 can
consulted for details regarding all the commands and feature
the program.

Typographical Conventions 2.1.2
Special fonts are used in the text to differentiate between norm
manual text and text displayed in the program.

Times This is the font used for the normal text in the manual.

Helvetica This is the font used for text that is displayed by the program
must be entered into the program by you.
WIN-EPR SimFonia User’s Manual



Installation Procedures
Installation Procedures 2.2

System Requirements 2.2.1

Hardware • minimum 4 M Byte RAM.

• arithmetic coprocessor.

• 1.2 or 1.44 m Byte floppy disk drive.

• minimum 80 M Byte hard disk.

• VGA graphics.

• Microsoft® compatible mouse.

• 1 parallel (Centronics) port.

• Microsoft Windows® supported printer.

Software • MS-DOS® operating system (version 3.3 or above.)

• Microsoft Windows® (version 3.1).
WIN-EPR SimFonia User’s Manual 2-2



Installation Procedures

-
is
gle
d to

m-
ter
our
ert

r to
he
urn

nd

ly

ile

 the

n

Installing WIN-EPR SimFonia 2.2.2
The BRUKER WIN-EPR SimFonia program is a protected soft
ware package. You may run it only if a dongle (WIBU-Key) 
connected to the parallel (Centronics) port of the PC. The don
is completely transparent for all command sequences directe
a printer, that may be connected to the same interface.

Installing the dongle is simple. Exit Windows and turn the co
puter off. Once you have turned it off, locate the parallel prin
connector. You may have to refer to the documentation for y
PC to find it. Disconnect the printer cable (if connected), ins
and screw the dongle into the 25 pin parallel port connector and
insert and screw the printer cable onto the dongle. In orde
avoid future problems, we highly recommend tightening t
screws of the software protection key and the printer cable. T
the computer back on.

Note: Before you start the automatic installation of WIN-EPR SimFo-
nia, you must be sure that MS-WINDOWS 3.1 is installed a
running without problems. 

1. Make sure that the dongle (WIBU key) is proper
installed on the parallel port of your PC.

2. Start Microsoft Windows in 386 enhanced mode.

3. Insert the WIN-EPR SimFonia disk in drive A.

4. From the File menu in either the Program Manager or F
Manager, choose Run.

5. Type a:install

6. Press ENTER

7. Follow the Setup instructions on the screen.

The program starts a dialog asking for the device name and
full path to where the program files should be copied. The
default is C:\EPR. If the WIN-EPR processing program or a
WIN-EPR SimFonia User’s Manual 2-3
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earlier version of WIN-EPR SimFonia can be found on the hard
disk, its directory is proposed. You may also change both 
device name or path. To continue with the automatic installat
click on Install or stop it with a click on Exit. If the selected
directory does not exist, you are questioned whether it should
created or not.

After copying the program files to their destination directories
new program group is generated in which you will find the ic
for WIN-EPR SimFonia. If  you have WIN-EPR already
installed, the icon for WIN-EPR SimFonia appears in the
WIN-EPR program group.

The installation is now finished. The WIN-EPR SimFonia pro-
gram can now be started.

Starting WIN-EPR SimFonia 2.3
1. In the Program Manager window, double-click the

WIN-EPR group icon or the group icon that contain
WIN-EPR SimFonia.

2. To start SimFonia, double-click the WIN-EPR SimFonia
icon.
WIN-EPR SimFonia User’s Manual 2-4
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Theory 3

This chapter is meant to be a brief description of the algorith
and the features of the SimFonia simulation program. It is not
meant to be an exhaustive treatise on the theory of EPR.
highly recommend exploring the following texts to familiarize
yourself with basic theories. In this way, you can fully bene
from the simulation program.

Solution
Spectra

• Weil, J.A. , J.R. Bolton, J.E. Wertz, Electron Paramagnetic
Resonance, Elementary Theory and Practical Applications:
Wiley-Interscience, New York, (1994).

• Atherton, N.M., Principles of Electron Spin Resonance, El
mentary Theory and Practical Applications: Wiley-Inter-
science, New York, (1994).

Powder
Spectra

• Abragam, A., B. Bleaney. Electron Paramagnetic Resonanc
of Transition Ions: Clarendon Press, Oxford, (1970).

• Pilbrow, J.R., Transition Ion Electron Paramagnetic Reso
nance: Clarendon Press, Oxford, (1990).

Solution Simulations 3.1
The first question to ask is, “What is meant by solution?”. So
tion in this case means a liquid sample. In a nonviscous liq
the paramagnetic species which we want to simulate are t
bling very rapidly. In fact they are tumbling so rapidly that their
anisotropic interactions (interactions which change with the o
entation of the magnetic field with respect to the complex or r
ical) are averaged out. What remains are the isotro
interactions (interactions which do not change with the orien
tion of the magnetic field with respect to the complex or radic
such as Fermi contact interactions. In some cases, the tumb
is not sufficiently fast to completely average the anisotrop
WIN-EPR SimFonia User’s Manual
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interactions. This incomplete averaging results in mi dependent
linewidths. These two cases are treated in the solution sim
tion part of SimFonia program.

The algorithm used in the SimFonia program is based on pertur
bation theory. Historically, perturbation theory has been use
the interpretation of EPR spectra because of the speed of c
lation and the intuitiveness of the results. It is an approximat
technique for finding the energy eigenvalues and the eigenv
tors of the spin hamiltonian (the equations used to described
EPR spectrum of the sample). Perturbation theory is covere
any introductory quantum mechanics text book.

As stated in the previous paragraph, perturbation theory is
approximation. The assumption made is that there is a domi
interaction which is much larger than the other interactions.
the dominant interaction becomes larger compared to the oth
interactions, the approximation becomes better. The three in
actions considered in the SimFonia simulation program for solu-
tion samples are the electronic Zeeman interaction, the nuc
hyperfine interaction, and the nuclear Zeeman interaction. T
electronic Zeeman interaction is the interaction of the magn
moment of the electron with the externally applied magne
field (i.e. the magnetic field from the spectrometer magnet). T
nuclear hyperfine interaction is the interaction between the m
netic moment of the electron with the magnetic moment of 
nucleus. The nuclear Zeeman interaction is the interaction of
magnetic moment of the nucleus with the externally appl
magnetic field. 

The assumption made in the simulations is that the electro
Zeeman interaction is the largest, followed by the hyperfi
interaction and the nuclear hyperfine term is the smallest. T
approximations start to break down if this is not true. Pertur
tion theory works best when the ratio between the succes
interactions is at least ten. For example, if the electronic Zeem
interaction is 10 GHz, the nuclear hyperfine interaction sho
WIN-EPR SimFonia User’s Manual 3-2
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be at most 1 GHz, and the nuclear Zeeman interaction sho
have a maximum value of 100 MHz. If these limits a
exceeded, perturbation theory still gives a “good” picture of 
EPR spectrum; however, it might not be suitable for quantitative
analyses.

Perturbation theory can be carried out to different orders
approximation. As the order of the approximation increases,
accuracy of the approximation increases. The default order
the solution simulations is first order. If you need to simulate
EPR spectrum with large hyperfine interactions, you can se
third order perturbation theory to increase the accuracy of 
simulation.

Only “allowed” EPR transitions are simulated. Under some c
cumstances, “forbidden” transitions can appear. These co
spond to a simultaneous flip of the nucleus and a flop of 
electron and the forbidden EPR lines occur between the allo
transitions. These forbidden lines are not simulated because per-
turbation theory is not the optimal method for calculating th
positions and intensities. Extra lines can also appear in a sp
trum if there are several nuclei which are equivalent. These l
appear as a consequence of higher order perturbation th
terms. If you choose third order perturbation theory in the sim
lation software, these extra lines are simulated.

The SimFonia solution simulation program simulates EPR spe
tra for spin 1/2 electronic systems only. There are essentially no
restrictions on the spin of the nuclei. All naturally occurrin
spins have been programmed.

There are two commonly occurring lineshapes in EPR, Loren
ian and Gaussian. Lorentzian lineshapes occur when the l
width of the signal is dominated by relaxation effects. Gauss
lineshapes usually occur when there is unresolved hyper
structure. SimFonia can simulate both types of lineshapes, 
well as a combination of the two. It was mentioned in the fi
paragraph of this section, that you can also observe mi depen-
WIN-EPR SimFonia User’s Manual 3-3
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dent linewidths when the anisotropic interactions are not co
pletely averaged out by rapid tumbling. Quite often, you c
express the linewidths as a polynomial in mi. For example, the
linewidth can be described as:

[3-1]

In these cases, SimFonia can simulate the mi linewidth depen-
dence if you supply the coefficients, a, b, and c. You can ob
these values interactively by using the Autocalc routine that 
the a, b, and c values by least squares.

SimFonia uses a Fourier transform technique to generate 
EPR spectra. The technique has many advantages for simul
solution spectra. The first advantage is that complicated spe
can be simulated very quickly and with very little comput
memory by performing convolutions in frequency space. Th
are essentially no limitations on the number of lines which c
be simulated. In fact, the efficiency of the algorithm increases
the number of nuclei increases. SimFonia can handle up to
twenty different nuclei with an unlimited number of equivale
nuclei.

The Fourier technique introduces some consequences w
may seem counterintuitive to you. For example, it requires more
time to simulate an EPR spectrum with narrow linewidths th
to simulate an EPR spectrum with broad lines. (Remember th
wide line in time or field space is a narrow line in frequen
space and vice versa.) This is particularly evident when the l
width of the EPR linewidth is equal to or less than the field s
size in the EPR spectrum. Also, it is faster to simulate a “who
spectrum than to simulate just part of it. This must be so in or
to avoid problems with foldover.

A second advantage of the Fourier method is that the effec
the isotopic abundance of the nuclei can be calculated v

Linewidth mi( ) a bmi cmi
2
  .+ +=
WIN-EPR SimFonia User’s Manual 3-4
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quickly when using first order perturbation theory. All possib
statistical distributions of the isotopes are easily generated.
third order perturbation theory calculation, all the statistical d
tributions must be explicitly calculated, hence resulting in
longer calculation time.

A third advantage of the Fourier method is that different inst
ment response functions can also be included. For example, Sim-
Fonia can simulate the effect of overmodulating your EP
spectrum or using too long of a time constant.

Powder Simulations 3.2
A powder means a sample composed of many small single c
tals or a glass. The paramagnetic species are moving so sl
that their anisotropic interactions (interactions which chan
with the orientation of the magnetic field with respect to t
complex or radical) are not averaged out. The resulting spect
is called a powder pattern.

As stated in “Powder Simulations” on page 5, the algorithm u
in the SimFonia program is based on perturbation theory. Histo
ically, perturbation theory has been used in the interpretatio
EPR spectra because of the speed of calculation and the 
itiveness of the results. It is an approximation technique for fi
ing the energy eigenvalues and the eigenvectors of the 
hamiltonian (the equations used to described the EPR spec
of the sample). Perturbation theory is covered in any introd
tory quantum mechanics text book.

As stated in the previous paragraph, perturbation theory is
approximation. The assumption made is that there is a domi
interaction which is much larger than the other interactions.
the dominant interaction becomes larger compared to the oth
interactions, the approximation becomes better. The five inte
tions which are considered in the SimFonia simulation program
WIN-EPR SimFonia User’s Manual 3-5
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for powder samples are the electronic Zeeman interaction,
zero field splitting, the nuclear hyperfine interaction, the nucle
quadrupole interaction, and the nuclear Zeeman interaction. 
electronic Zeeman interaction is the interaction of the magn
moment of the electron with the externally applied magne
field (i.e. the magnetic field from the spectrometer magnet). T
zero field splitting occurs in electronic systems in which the s
is greater than 1/2. The nuclear hyperfine interaction is the in
action between the magnet moment of the electron with the m
netic moment of the nucleus. The nuclear quadrupole interac
is the interaction between the quadrupole moment of the nuc
with the local electric field gradients in the radical or comple
The nuclear Zeeman interaction is the interaction of the m
netic moment of the nucleus with the externally applied ma
netic field.

The assumption made in the simulations is that the electro
Zeeman interaction is the largest, followed by the zero fie
splitting, hyperfine interaction, nuclear quadrupole interaction,
and the nuclear hyperfine term is the smallest. The approxi
tions start to break down if this is not true. Perturbation the
works best when the ratio between the successive interactio
at least ten. For example, if the electronic Zeeman interactio
10 GHz, the zero field splitting should be at most 1 GHz. If thes
limits are exceeded, perturbation theory still gives a “good” p
ture of the EPR spectrum; however, it might not be suitable
quantitative analyses.

Perturbation theory can be carried out to different orders
approximation. As the order of the approximation increases,
accuracy of the approximation increases. The default order
the powder simulations is first order. If you need to simulate
EPR spectrum with large hyperfine interactions, you can se
second order perturbation theory to increase the accuracy o
simulation. The zero field splittings are always treated to second
order because they do not produce a non-zero first order te
WIN-EPR SimFonia User’s Manual 3-6
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Note: all cross terms between the different interactions h
been implemented.

Only “allowed” EPR transitions are simulated. Under some c
cumstances, “forbidden” transitions can appear. These co
spond to a simultaneous flip of the nucleus and a flop of 
electron and the forbidden EPR lines occur between the allo
transitions or a ∆M = 2 electronic transition. These forbidde
lines are not simulated because perturbation theory is not
optimal method for calculating their positions and intensities.

The SimFonia powder simulation program simulates EPR spe
tra for spin 1/2 to spin 7/2 electronic systems. For spins gre
than 1/2, D and E zero field splitting terms are implement
There are essentially no restrictions on the spin of the nuclei.
naturally occurring spins have been programmed.

The anisotropic interactions possess a principal axis syst
This axis system is a choice of axes in which the interact
matrix (or tensor) is diagonal (simplified). The principal axes
the electronic Zeeman interaction and the zero field splitting 
assumed to be coincident. No assumptions are made rega
the principal axes of the other interactions.

There are two commonly occurring lineshapes in EPR, Loren
ian and Gaussian. Lorentzian lineshapes occur when the l
width of the signal is dominated by relaxation effects. Gauss
lineshapes usually occur when there is unresolved hyper
structure. SimFonia can simulate both types of lineshapes, 
well as a combination of the two. Quite often, the linewidths c
vary as a function of the direction of the externally applied ma
netic field.   For example, the linewidths can be described as

[3-2]

where lx, ly and lz are the direction cosines of the magnetic fie
on the electronic Zeeman principal axes and wx, wy, and wz are

          Linewidth lx ly l z, ,( ) wx
2
lx
2

wy
2
l y
2

wz
2
l z
2

+ +  ,=
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the linewidths along the principal axes. In these cases, SimFonia
can simulate the orientational dependence of the linewidth.

Calculating powder spectra requires sampling many orientations
of the magnetic field (often called spherical integration
Because of time reversal symmetry, we need consider orie
tions in one hemisphere only. For a specific value of θ, the num-
ber of φ angles is chosen for proper statistical weighting. T
values to be entered into the program are the number of ste
θ from 0 to π/2 and the number of steps in φ along the equator. In
this manner, if all interactions are axially symmetric, the numb
of φ angles can be set to 1 and the integration is very quick. 
number of θ and φ values required for a given simulatio
depends on how anisotropic the spectra are compared to the
widths. A common occurrence when simulating highly anisotro
pic spectra with narrow linewidths is the appearance of “gra
in a simulated spectra. This happens because we have
included enough orientations in the simulation and we are in 
resolving the spectra due to individual crystallites having a s
cific orientation in the powder. Increasing the number of ang
alleviates this problem.

The FFT technique is too slow for powder simulations. Th
technique is most efficient for many lined complicated spectra
but solids usually do not exhibit such spectra. Therefore, a stan-
dard lineshape algorithm is used to generate the spectra.
WIN-EPR SimFonia User’s Manual 3-8
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A SimFonia Tutorial 4

This chapter is a brief tutorial in using SimFonia to simulate EPR
spectra. It does not cover all the details of all operations (Tha
the purpose of the next chapter.) but will get you started in lea
ing how the software works. One of the quickest and eas
means of learning how to use the program is to use it a
explore the many features. The tutorial consists of three ex
ples that require the use of the most important features of
program.

Starting WIN-EPR SimFonia 4.1
In order to follow the tutorial you will need to start the progra
running. You should have Microsoft® Windows™ already run-
ning. Consult your Windows™ documentation for details. Dou-
ble-c l ick the WIN-EPR program group icon and the
double-click the WIN-EPR SimFonia application icon. (See
Figure 4-1.) 

Figure 4-1 The WIN-EPR SimFonia application icon.

SimFonia
Icon

Program
Group
Icon
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Durosemiquinone Radical Anion 4.2
Quinones are important in many biological processes beca
they easily change oxidation state. The radical anions are e
prepared by dissolving the compound in an alcohol or DMS
(Dimethyl Sulfoxide) and adding some KOH. The oxygen in t
atmosphere oxidizes the quinone. The example we shall loo
here is durosemiquinone in DMSO. It serves as a good exam
for solution spectra and an accurate simulation requires many o
SimFonia’s features such as interactive entry of g- and a- valu
isotopic abundances, and comparing experimental and simula
spectra.

Figure 4-2 The structure of the durosemiquinone anion.
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The major feature of the durosemiquinone anion EPR spect
is the thirteen line splitting caused by the twelve equivalent pro-
tons of  the four  methy l  groups.  (See F igure 4-2 an
Figure 4-3.) The relative intensities follow the familiar Pasca
triangle or binomial coefficients and are:

1 : 12 : 66 : 220 : 495 : 792 : 924 : 792 : 495 : 220 : 66 : 12 : 

Another thing to notice is that there are a number of less inte
lines between the proton lines. These signals arise from na
abundance 13C in the radical. One pair of 13C “satellites” comes
from the equivalent carbons of the four methyl groups. Anot
set originates from the four equivalent ring carbons to which 
methyl groups are attached. The third type of carbon site in
molecule are the two ring carbons attached to the oxygen. Th
13C’s do not exhibit a hyperfine splitting because there are fewe
of them (only two) and the lines may be broadened owing
incompletely averaged anisotropic hyperfine interactions.

Figure 4-3 The durosemiquinone radical anion EPR spectrum.
WIN-EPR SimFonia User’s Manual 4-3



Durosemiquinone Radical Anion

m
es-
 we
the
Loading an Experimental Spectrum 4.2.1
The first thing we need to do is to load an experimental spectru
into the application. We can then obtain the information nec
sary for the simulation. We then have a spectrum with which
can compare and contrast the simulation as well. Click on 
Fi le  menu and a d rop-down menu w i l l  appea r.  (See
Figure 4-4.) 

Figure 4-4 The File drop-down menu.
WIN-EPR SimFonia User’s Manual 4-4
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Click on the Load Experiment Spectrum command and a dia-
log box will appear. (See Figure 4-5.) From this dialog box, y
can load a spectra from a diskette or a hard disk drive. To se
the appropriate disk drive, click on the arrow on the Drives:
selector and click the appropriate drive icon. To select the ap
priate directory or path, click on the appropriate paths in 
Directories: selector. The sub-directory in which the examp
spectra are usually kept is c:\...\winepr\simdata. The spectrum
is selected by clicking on the desired spectrum file or typing 
filename in the File Name selector. For this example, we nee
the file duro_an.spc. Clicking OK loads the spectrum into the
program. Once the file is loaded, it will appear in a spectr
window as a red spectrum.

Figure 4-5 The Load Experiment Spectrum dialog
box.
WIN-EPR SimFonia User’s Manual 4-5
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To ensure that all the proper dialog boxes for a solution simu
tion (and not a powder simulation) appear, our first task is
se lect  the Solution  opt ion. Click on the arrow of  the
Solution / Powder drop-down list in the tool bar and click on
Solution. (See Figure 4-6.)

Figure 4-6 Display of the experimental spectrum and the Solution/Powder selec-
tor.

Solution /
Powder

Instrument
Parameters

Button
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Once a solution simulation has been chosen, we must enter 
instrument parameters used to acquire the experimental s
trum into the simulation program. To open the Instrument
Parameter dialog box, click on the I button in the tool bar (See
Figure 4-6.) and the dialog box will appear. Click on the Get
Exp. Parameters button to set the instrument parameters (such
as center field, sweep width, modulation amplitude, etc.) for the
simulation to the parameters used in the experimental spect
(See Figure 4-7.) Click OK to return to the main application
window.

Figure 4-7 The Instrument Parameters dialog box.

Get
Exp.
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Determining the g-value 4.2.2
The first spin hamiltonian parameter that must be specified fo
simulation is the g-value. The g-value of a radical determines
position of the center point of the EPR spectrum. One reason
first entering a g-value is simply convenience. A more obsc
reason is given in the next section where we shall meas
hyperfine coupling constants. Most organic radicals hav
g-value very close to 2.00.

In order to interactively determine the g-value of the exp
imental spectrum, we need to open the Hamiltonian Param-
eters dialog box. Clicking on the H button in the tool bar
(next to the I button) will cause this dialog box to appear.

Figure 4-8 The Hamiltonian Parameters dialog box.

Exp
Button
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The default g-value is 2.00232 (the free electron value) an
displayed in the lower left corner of the dialog box. Click on t
Exp button next to the display to interactively determine t
g-value. (See Figure 4-8.) A new dialog box will appear with
marker (vertical l ine) that moves with the cursor. (Se
Figure 4-9.) The g-value calculated from the magnetic fie
position of the marker and the microwave frequency is display
next to Electron G-Factor. The formula used is:

[4-1]

where h is Planck’s constant, ν is the microwave frequency, µB
is the Bohr magneton, and B0 is the magnetic field.

In order to determine the g-value, place the marker in the ce
of the EPR spectrum. Clicking the right mouse button fixes 
positions of the marker. Clicking OK enters the g-value into the
hamiltonian window. The g-value for the durosemiquinone ra
cal anion in DMSO is 2.00465.

g
hν

µBB0
-------------  ,=

Figure 4-9 The interactive g-value determination dialog box.
WIN-EPR SimFonia User’s Manual 4-9
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To facilitate more precise positioning of the marker, you can use
the zooming and expansion features of this window. (S
Figure 4-10.) To zoom in on a particular area of the spectru
click the Scaling button. When this option is active, clicking th
left mouse button toggles the cursor between the lower right 
upper left corner of the zoom rectangle. As you move the cur
the position of the rectangle corner moves with the cursor. Clic
ing with the right mouse button expands the region encompass
by the rectangle to fill the whole window. Clicking the Reset
button will return the display back to its full range.

A few brief words of warning are in order if you are trying 
measure the g-values of your samples. First, you need a
quency counter to measure your microwave frequency. T
value in the display of the acquisition software is only 
approximate value. Second, if you are not using an ER03
NMR Gaussmeter, you are measuring the magnetic field at
Hall probe of the field controller and not the field at the samp
The magnetic field at the sample can be three or four Ga
higher than at the Hall probe, resulting in a discrepancy of ab

Figure 4-10 Zooming in on a portion of a spectrum.
WIN-EPR SimFonia User’s Manual 4-10
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0.1%. If you need very precise g-value determinations, i
important to use both a microwave frequency counter and
NMR Gaussmeter.

Determining the Hyperfine Coupling Constants 4.2.3
Once the g-value has been measured, we can determine
hyperfine coupling constants (also known as a-values) using
experimental spectrum. The procedure is similar to determin
the g-value in the previous section.

Using the approximation of first order perturbation theory, t
magnetic fields at which EPR signals occur is given by:

[4-2]

where a is the a-value, mI is the nuclear magnetic quantum num
ber, and the other constants and variables are as defined i
previous section. The spectrum will then consist of a series
lines with an equal magnetic field spacing of:

[4-3]

B0
hν

gµB
----------

amI

gµB
----------  ,–=

∆B
amI

gµB
----------   .=

Figure 4-11 First order hyperfine splittings.

∆B
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The hyperfine coupling constant can be expressed in many
ferent types of units. Perhaps the most common units is Gau
which the value is simply the splitting of the EPR lines:

[4-4]

Another common unit for the hyperfine splitting is MHz (fre
quency). The value for the hyperfine coupling in terms of t
magnetic field spacing is:

[4-5]

A third alternative available in WIN-EPR SimFonia is cm-1. The
value for the hyperfine coupling in terms of the magnetic fie
spacing is:

[4-6]

where c is the speed of light.

The choice of units for the hyperfine coupling constant can be a
topic for heated debate. Each choice has its advantages
drawbacks. If we use Gauss and first order perturbation theory is
sufficient, the a-value follows directly from the magnetic fie
splittings. To measure the a-value in MHz or cm-1, we need
a priori knowledge of the g-value. In order to theoretically inte
pret the a-value in Gauss in terms spin densities, we still n
the g-value. For this example, it is convenient to use Gauss.

a(Gauss) ∆B  .=

a(MHz)
∆BgµB

h
------------------  .=

a(cm
1– )

∆BgµB

hc
------------------  ,=
WIN-EPR SimFonia User’s Manual 4-12
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First, we shall measure the a-value for the methyl protons. If 
closed the Hamiltonian Parameters dialog box after determin-
ing the g-value, you will need to open it once more. We can e
a few parameters first before measuring the a-values from
experimental spectrum. Enter 12 in the # Nuclei box since we
are simulating the spectrum of a radical with 12 equivalent p
tons. Click the up arrow next to the Spin box to select 1/2 since
protons have a spin of 1/2. Click on the arrow of theA
drop-down list in the tool bar and click on [G] to select Gauss as
our units.

Figure 4-12 The Hamiltonian Parameters dialog box.
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Now we can determine the a-value from the experimental sp
trum. Click on the Exp button shown in Figure 4-12. A new
dialog box will appear with two markers (vertical lines) th
move with the cursor. (See Figure 4-13.) The a-value calcula
from the difference of the magnetic field positions of the ma
ers is displayed next to Hyperfine Constant.

In order to determine the a-value, place the markers on the 
ters of adjacent hyperfine lines in the EPR spectrum. Click
the left mouse button exchanges the marker that moves with
cursor. Clicking the right mouse button fixes the positions
both markers. Clicking OK enters the a-value into the hamilto-
nian window. As in the interactive determination of the g-valu
you may zoom in on a section of the spectrum to carefully posi-
tion the cursors. Figure 4-13 shows what the display may lo
like. The a-value for the protons in the durosemiquinone rad
anion in DMSO is 1.821 G, as determined by ENDOR spectr
copy. Clicking the Insert button enters the parameters into
parameter list for the simulation. (See Figure 4-14.)

Figure 4-13 The interactive a-value determination dialog box.
WIN-EPR SimFonia User’s Manual 4-14
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Most of the carbons are spinless 12C and result in the intense
“main” signal. In the introduction to this section, it was me
tioned that there are also “extra lines” due to fairly low natu
abundance (about 1%) spin 1/2 13C nuclei in the radical.
WIN-EPR SimFonia implements the Bruker ENDOR tables in
convenient and intuitive periodic table interface. Clicking on t
Get Element button opens the Element Data dialog box.

Figure 4-14 The Hamiltonian Parameters dialog box.
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Click on the carbon (C) to access the data on the isotopes of c
bon. Clicking on the OK button returns you to the Hamiltonian
Parameters dialog box and enters the carbon isotope data s
as natural abundances and spins into the window. We must enter
the number of equivalent nuclei (4) into the # Nuclei box.

Click the Exp button to interactively determine the a-va
ues of the 13C nuclei. Remember to insert the paramete
into the parameter list for the simulation. This whole pr
cedure must be repeated for the second set of 13C nuclei as
well. (See the next two figures for approximate positioni
of the cursors.) The a-values for the two types of carb
are 1.37 G and 0.49 G.

Figure 4-15 The Element Data dialog box.
WIN-EPR SimFonia User’s Manual 4-16
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It is a good idea, in general, to use third order perturbation t
ory for simulations. To implement the higher order algorith

Figure 4-16 Hyperfine splitting due to four methyl carbons.

Figure 4-17 Hyperfine splitting due to four ring carbons.
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click on the Third Order box. When you are finished, the
Hamiltonian Parameters dialog box should look similar to
Figure 4-18. Click OK to return to the application window.

Figure 4-18 The Hamiltonian Parameters dialog box.
WIN-EPR SimFonia User’s Manual 4-18
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Line Shapes 4.2.4
The radicals in this sample are tumbling rapidly enough in so
tion and there are not too many nuclei. As a consequence
line shapes are determined by relaxation effects, resultin
lorentzian line shapes. The line width (peak to peak) is approxi-
mately 50 mG.

To enter the required parameters for the line shapes, we ne
open the Shape Parameters dialog box. Click on the S button
in the tool bar. The dialog box will then appear. Enter in a va
of 0.00 in the Lorentzian / Gaussian box. This corresponds 
purely lorentzian line shape. Enter 0.05 in the Linewidth box.
Clicking the OK button returns you to the main application win
dow.

Figure 4-19 The Shape Parameters dialog box.
WIN-EPR SimFonia User’s Manual 4-19
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Simulating and Comparing Spectra 4.2.5
To start a simulation, click the RUN button in the tool bar. The
simulation will then run and display the simulated spectru
upon completion. If you wish to stop the simulation click th
STOP button next to the RUN button.

Figure 4-20 Display of the experimental and simulated spectra.
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A convenient means of comparing your simulated spectrum w
the experimental spectrum is to look at the difference betw
them. Click on the Operation menu and click on Algebra.
Selecting the Algebra command allows you to display the dif
ference. Click the Maximize button to increase the size of th
spectrum window. After performing these operations, the diff
ence (or result) spectrum is displayed in the spectrum window
new tool bar also appears with which you can adjust the prop
ties of the simulated spectrum such as the size or shifting
spectrum left and right.

Figure 4-21 The Algebra tool bar.
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Another convenient means of comparing spectra is to over
the simulated spectrum on top of the experimental spectrum
do this, click on the View menu and click on Overlay. You can
then directly compare the two spectra.

By zooming in on an area of the spectra, you can carefully adjust
the size and left/right shift of the simulated spectrum. The Fac-
tor and Constant (the y-size and y-offset) can be easily adjust
by selecting one or the other in the drop-down list. The val
are changed by moving the slider bar left and right to decreas
increase the parameter value which is displayed next to
drop-down list. The sensitivity (the amount of change in t
parameter value per distance moved) of the slider bar is sele

Figure 4-22 The View drop-down menu and the Overlay command.
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by clicking the /10 and *10 buttons and the sensitivity is dis
played between the two buttons.

You can also move the simulated spectrum right and left w
respect to the experimental spectrum by selecting either
X-Offset or X-Offset (Pt) in the drop-down list. The value in
the parameter value display has the units of the x-axis 
X-Offset and units of points or addresses for X-Offset (Pt).
Moving the slider bar left moves the spectrum left and rig
moves the spectrum right. The sensitivity (the amount of cha
in the parameter value per distance moved) of the slider ba
selected by clicking the /10 and *10 buttons and the sensitivity
is displayed between the two buttons.

Figure 4-23 Careful adjustment of the size of the simulated spectrum.
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Fremy Salt in Glycerol 4.3
Fremy salt (peroxylamine disulfonate) is a nitroxide radical that
exhibits a three line EPR spectrum due to the nitrogen nucl
The line shape is determined by the relaxation times owing
absence of many strongly coupled nuclei. The relaxation tim
of each of the nitrogen hyperfine lines depends on the rotatio
correlation time because of incompletely averaged anisotrop
When the radical is dissolved in a viscous solvent such as g
erol, mi dependent linewidths result.

Quite often, you can express the linewidths as a polynomia
mi. For example, the linewidth may be described as:

[4-7]

In these cases, SimFonia can simulate the mi linewidth depen-
dence if you supply the coefficients, a, b, and c. You may obta
these values interactively by using the calculate Constants
routine that fits the a, b, and c values by least squares.

Figure 4-24 Varying linewidths owing to incompletely averaged anisotropies in a
viscous liquid.

Linewidth mi( ) a bmi cmi
2
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g- and a- Values for Fremy Salt 4.3.1
For this example, we need the load the experimental spect
frem_gly.spc. The sub-directory in which the example spect
are usually kept is c:\...\winepr\simdata. Please follow the
instructions of the previous section to set the experimen
parameters as well as determine the g-value and the a-va
After you finish, the Hamiltonian Parameter dialog box should
have similar entries as in Figure 4-25.

Figure 4-25 Spin hamiltonian parameters for Fremy salt
in glycerol.
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mi Linewidth Dependence 4.3.2
To enter the required parameters for the linewidths, we nee
open the Shape Parameters dialog box. Click on the S button
in the tool bar. The dialog box will then appear. Enter in a va
of 0.00 in the Lorentzian / Gaussian box. This corresponds to
a purely lorentzian line shape.

Next, click on the Tumbling Effect box to implements an mi
dependent linewidth calculation. An x in the box indicates th
the option is active. If no valid nucleus were chosen, (i.e. no
third order calculation, more than one nucleus, spin less than
this box is grayed and hence is not available.

The Nucleus box indicates which nucleus is used to calcula
the mi dependent linewidth. In our case, this is nucleus num
one. It is assumed that the nucleus has only one equiva
nucleus, that there is only one isotope, the calculation is p
formed with third order perturbation theory, and that the spin
greater than 1.

Figure 4-26 The Shape Parameters dialog box.
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Click on the calculate Constants button to open up a new win
dow that allows you to enter the 2 * I + 1 (where I is the spin
the nucleus) linewidths necessary to fit a, b, and c. The num
of linewidths required for the calculation is displayed next to#
of areas to define. Place the right and left markers (vertica
l ines) on the peak points of the EPR line to define t
peak-to-peak linewidth. The manner in which the markers w
is identical to the interactive a-value determination. The mar
that moves with the cursor may be toggled by clicking the l
mouse button. Clicking the right mouse button fixes the po
tions of the markers. If the Optimize Areas option is in effect
(the default option), the software will search for the peaks in 
vicinity of the markers. You still need to place the cursors
close as possible to the peaks for this option to work well. After
the markers are fixed, a new set will appear until all the requ
2 * I + 1 linewidths are marked. The number of linewidths y
have already defined is tallied next to areas defined. The OK
command returns you to the Shape dialog box and calculates a
b, and c automatically. If you click Cancel, you return to the
Shape dialog box with no changes made.

Figure 4-27 The calculate Constants dialog box.
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Click on the OK button in the Shape Parameters dialog box to
return to the main applications window.

Simulating and Comparing Spectra 4.3.3
Run the simulation by clicking on the RUN button in the tool
bar. You may also select the Algebra and Overlay options as we
did in Section 4.2.5 to compare your simulated and experim
tal spectrum as shown in Figure 4-28.

Figure 4-28 Comparison of simulated and experimental spectra of Fremy Salt in
glycerol.
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53Cr+3 in CsAl(SO 4)2 • 12 H2O 4.4
The final example for this tutorial is a powder sample. A powd
means a sample composed of many small single crystals 
glass. The paramagnetic species are moving so slowly that 
anisotropic interactions (interactions which change with the o
entation of the magnetic field with respect to the complex or r
ical) are not averaged out. The resulting spectrum is calle
powder pattern.

Trivalent chromium often can easily substitute for aluminum
inorganic complexes. CsAl(SO4)2 • 12 H2O is a convenient and
easy to grow crystal into which Cr+3 can substituted. The crys-
tals can be ground into a fine powder to produce a v
nice and instructive powder spectrum.

Figure 4-29 Selection of the powder option.
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To ensure that all the proper dialog boxes for a powder sim
tion (and not a solution simulation) appear, our first task is
select  the Powder  opt ion.  Cl ick on  the arrow of  the
Solution / Powder drop-down list in the tool bar and click on
Powder. (See Figure 4-29.)

The center field and sweep width appropriate for this sample
shown in Figure 4-30.

Figure 4-30 Instrument parameters for 53Cr+3 in CsAl(SO4)2 . 12 H2O.
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Spin Hamiltonian Parameters 4.4.1
Trivalent chromium has a spin of S = 3/2. As with most high
spin electronic systems, there will be a zero field splitting (com-
monly abbreviated as ZFS) that may be parameterized by
two constants D and E. The Zeeman interaction is isotrop
yielding a diagonal g-matrix. The hyperfine interaction with th
53Cr nucleus (I = 3/2) is isotropic as well.

P lease f i l l  in the parameter  values  that  are shown
Figure 4-31. Note that the choice of units are 10-4 cm-1.

Figure 4-31 Spin hamiltonian parameters for 53Cr+3 in
CsAl(SO4)2 . 12 H2O.
WIN-EPR SimFonia User’s Manual 4-31



53Cr+3 in CsAl(SO4)2 • 12 H2O

re-
lei.
ion
e-

ld

en-
 the
e
ase
Line Shapes 4.4.2
This compound exhibits Gaussian lineshapes owing to un
solved hyperfine structure from the protons, Cs, and Al nuc
Quite often, the linewidths can vary as a function of the direct
of the externally applied magnetic field.   For example, the lin
widths can be described as:

[4-8]

where lx, ly and lz are the direction cosines of the magnetic fie
on the electronic Zeeman principal axes and wx, wy, and wz are
the linewidths along the principal axes. This orientation dep
dence is the reason that there are three linewidth entries in
Shape Parameters dialog box for powder simulations. We ar
fortunate to have an isotropic linewidth in this sample. Ple
enter a value of 15 Gauss in each of the linewidth boxes.

Figure 4-32 The Shape Parameters dialog box.
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Spherical Averaging 4.4.3
If we were to run a simulation with the parameters we ha
entered so far we would obtain a spectrum that looks l
Figure 4-33. Alas, this does not look much like what we would
expect. There are far too many lines cluttering the spectrum w
what is euphemistically called “grass”. The origin of the
unwanted features as well as a means of avoiding the grass
be understood by considering the technique used for the pow
simulation.

Figure 4-33 A “grassy” spectrum.
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A powder consists of a large collection of single crysta
each with a random orientation with respect to the m
netic field. Each orientation can be represented as a p
on the surface of a sphere. To accurately simulate a pow
spectrum requires simulating a spectrum for each orie
tion (essentially an infinite number of orientations) a
adding the individual spectra together. This process
known as spherical integration.

An infinite number of orientations would require an inf
nite time to simulate. As an approximation, we can divi
the sphere into a set of discrete values of latitude and lo
tude as shown in Figure 4-34. The finer the step size in
itude and longitude, the more accurately we simulat
random distribution of orientations and the smoother 
simulated powder spectrum becomes. The problem w
the simulation in Figure 4-33 is that we divided the sph
up too coarsely.

Figure 4-34 Approximation of a sphere using a finite
number of points.
WIN-EPR SimFonia User’s Manual 4-34



53Cr+3 in CsAl(SO4)2 • 12 H2O

-
he

he
his

 to

36.
The parameter, Number of Theta, corresponds to the num
ber of steps in latitude in going from the north pole to t
equator. The parameter Number of Phi corresponds to the
number of steps in longitude in going halfway around t
equator. In our example, we have axial symmetry. T
means that we only need one value for a longitude (Num-
ber of Phi = 1). We need more (or finer) steps in theta
obtain a smooth powder simulation. Changing Number of
Theta to 600 results in the spectrum shown in Figure 4-

Figure 4-35 Spin hamiltonian parameters for 53Cr+3 in
CsAl(SO4)2 . 12 H2O.
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Figure 4-36 A “smooth” powder simulation.
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Exporting Data 4.5
WIN-EPR SimFonia is predominately used to simulate spectr
It has not been designed to perform sophisticated post-proc
ing as is available in WIN-EPR. In order to get the spectrum i
another application, the spectrum must be saved. Click on
File menu and choose the Save As command. When you click
Save As, a dialog box appears that lets you choose a filenam
destination directory, and a destination disk drive. Each sp
trum consists of a spectrum file (*.spc filename extension) and a
parameter file (*.par filename extension). The default filenam
extension is *.par (for parameter) and when a parameter file
saved, it saves the corresponding spectrum file as well. To se
the appropriate disk drive, click on the arrow on the Drives:
selector. To select the appropriate directory or path, click on
appropriate paths in the Directories: selector and click the
appropriate drive icon. The spectrum filename is selected
clicking on the desired parameter file or typing the filename
the File Name selector. Clicking OK saves the spectrum on th
hard disk or diskette. Cancel exits the dialog box without saving
the spectrum.

Figure 4-37 The File Save As dialog box.
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The spectrum is saved in WIN-EPR format and can now
directly loaded into WIN-EPR for further processing. (Cons
your WIN-EPR documentation on how to load spectra.) Onc
spectrum has been loaded into WIN-EPR, it may be saved a
ASCII file so that it may be imported into other application
Click the Parameter menu and select the List Data File com-
mand. A new dialog box appears that allows you to either s
the file to the clipboard via the Copy command or into a file via
the Save command.

Figure 4-38 The List Data File dialog box of WIN-EPR.
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Command Reference 5

This chapter lists and describes all the menus, commands as
as operations of WIN-EPR SimFonia. It is meant as a referenc
and not as a tutorial. For those who are learning to use the 
gram, it is probably best to start with Chapter 4, A Tutorial. F
questions regarding Microsoft® Windows, please refer to you
Windows manual.

Brief Tips on Windows™ 3.x 5.1
Not everyone may be familiar with Microsoft® Windows™. The
following section is a brief explanation of some basic aspect
Windows™. It is not meant to be an in-depth treatise: t
Microsoft® documentation should be consulted for more deta
If you are already familiar with Windows™, you can easily skip
this section. If you have not used Windows™ before, we hig
recommend Microsoft’s on-line Windows™ tutorial. The tuto
rial can be found under Help.

Application
Window

All Windows™ programs operate in an application windo
WIN-EPR SimFonia displays all its commands and spectra in t
application window. 
WIN-EPR SimFonia User’s Manual
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Spectrum
Window

Simulated or experimental spectra are displayed in a spect
window. You may have multiple spectrum windows open at 
same time, however, only one is active at a time. The ac
spectrum window is the one upon which operations will be p
formed. Each spectrum window has its own set of simulat
parameters. The parameters viewed or edited in the menus c
spond to those of the active spectrum window. With defa
Microsoft® Windows colors, the active windows have a blu
title bar and the inactive windows have white title bars. You acti-

Figure 5-1 The parts of an applications window.
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vate a window by clicking it while the cursor is in the window
Spectra may also be minimized to an icon at the bottom of
application window.

Title
Bar

The bar at the top of a window is the tit le bar. Both t
WIN-EPR application window and the spectrum windows ha
title bars. It shows the name of the application or of the spect
window. The color of the title bar indicates whether a window
active or not. (See above.) By clicking and dragging the title b
the window may be moved.

Other elements of the title bar are as follows.

Maximize
Button

A click on the maximize button of the application windo
expands it to fill the entire screen. Clicking on the maximize b
ton of the spectrum expands it to fill the entire area of the ap
cation window. You may restore the window to its original si
by clicking the restore button.

Minimize
Button

Clicking on the minimize button of the application windo
shrinks it to an icon at the bottom of the screen. A click on 
minimize button of the spectrum shrinks it to an icon at the b
tom of the application window.You may restore the window 
its original size by double-clicking the icon.

Restore
Button

A click on the restore button returns the window to its previo
size and locations. This button reverses the effect of using
maximize button.

Control
Menu

Box

Double-clicking this box closes the window. A single mou
click opens a drop-down menu. Consult your Microsoft® Win-
dows documentation for further information regarding the co
mands in the menu.
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Menu
Bar

The horizontal bar near the top of the application window is 
menu bar. It displays the names of the available pull-do
menus. Choose the desired menu by clicking on it with the 
mouse button. The menu consists of a collection of comman
You choose a command by clicking on it with the left mou
button.

Tool
Bar

The horizontal bar below the menu bar is the tool bar. It displ
the icons of the most commonly used commands. Clicking on
icon performs the command.

Info
Line

The info line is a bar at the bottom of the application windo
The left corner displays messages regarding the prese
selected command or the status of the program. The two boxe
next to NUM display values of cursor positions when the app
priate options are active.

Window
Border

The perimeter of the window is the window border. When t
cursor is placed anywhere on the window border, a double ar
replaces the regular cursor. If you click and drag, the wind
may be resized to the desired size. If you drag a corner, the
sides that form the corner are resized simultaneously.
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Dialog Boxes 5.2

Many commands open a dialog box. The dialog box allows y
to enter required input for the simulation. What follows is
description of the basic elements of a dialog box and how to
them.

Editable
Box

The editable box is a plain box with a white background. As 
name suggests, you may edit the value in the box. It is used
the input and display of quantities that are not restricted to s
cific values but may have a continuum of values such as 
hyperfine coupling constant. After a click with the left mou
button in the text of the box, an insertion marker appears (a 
tical line). Any text (or numbers) you type are inserted after 
insertion marker. Several characters may be selected or h
lighted simultaneously by clicking and dragging over the desi
text. Any typed text replaces the highlighted text. The select

Figure 5-2 The parts of a dialog box.
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text may also be deleted by pressing the Del key. The left and
right arrow keys of the keyboard moves the insertion marker 
and right. Keeping the keys pressed auto-repeats the action.

Drop-down
List

This input method is used for parameters which have a limited
number of options or choices. After clicking on the downwa
pointing arrow next to the box, the allowed values appear i
drop-down list. The presently active option is highlighted. T
highlighted choice is changed by pressing the up and do
arrow keys of the keyboard. You may select the desired cho
by clicking the value with the left mouse button. The drop-do
list then disappears with the newly selected value or option 
played in the box.

Check
Box

The check box acts like a toggle. When clicked, the action tu
the option on and off. A cross mark in the box indicates an on (or
active) state.

Push
Button

A push button will execute a command when you click it wi
the left mouse button. The command, such as OK or Cancel is
displayed in the center of the button.

Arrow
Buttons

The arrow buttons are used to change a variable in a disc
step-wise fashion. If the box has a white background, the va
may be edited as in an editable box. Clicking the up or do
arrow button increases or decreases the parameter with a 
step size. For example, the step size for modulation amplitud
0.1 Gauss. Keeping the mouse button pressed auto-repeat
action. If the background of the box were gray, the up and do
arrows next to the box move you through the allowed values
the variable sequentially. You are then not able to edit the val
WIN-EPR SimFonia User’s Manual 5-6
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Scroll
Bar

The Scroll Bar is used to view entries in a list. For example, it is
used in the Save As dialog box to choose subdirectories. Click
ing the up or down arrows scrolls the list up and down. Keep
the mouse button pressed auto-repeats the action. The pos
of the viewed entries in the list is indicated graphically by t
square. The list may be scrolled as well by clicking and dragg
the square.

OK
Button

This button returns you to the original window or dialog bo
when clicked. All the changes made in the dialog box are set

Cancel
Button

This button returns you to the original window or dialog bo
when clicked. All changes made in the dialog box are cancel
WIN-EPR SimFonia User’s Manual 5-7



The File Menu

m

The File Menu 5.3

New 5.3.1
Create a new simulation spectrum with default param-
eter settings.  The New command creates a new spectru
window in the application window.

Figure 5-3 The File drop-down menu.

Recent
Files
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Open 5.3.2
Open an existing spectrum.  The Open command loads a
spectrum from a diskette or a hard disk drive. After clickin
Open, a dialog box appears that allows you to select and loa
spectrum. Each Bruker spectrum consists of a spectrum 
(*.spc filename extension) and a parameter file (*.par filename
extension). The default filename extension is *.par (for parame-
ter) and when a parameter file is loaded, it loads the corresp
ing spectrum file as well. To select the appropriate disk dri
click on the arrow on the Drives: selector and click the appropri
ate drive icon. To select the appropriate directory or path, c
on the appropriate paths in the Directories: selector. The spec-
trum is selected by clicking on the desired parameter file or t
ing the filename in the File Name selector. Clicking OK loads
the spectrum into the program. Cancel exits the dialog box
without loading a spectrum.

Figure 5-4 The File Open dialog box.
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File

If you try to open a spectrum that is not in WIN-EPR or OS
format, the Import File dialog box appears.

The form of the data values is selected in Spectra Data Type.
The options are: 

• ASCII for ASCII values (non-binary data)

• integer: 2Byte (1_2) for 2 byte integers in ascending orde
(Motorola format)

• integer: 2Byte (2_1) for 2 byte integers in descending orde
(Intel format)

• integer: 4Byte (1_2_3_4) for 4 byte integers in ascending
order (Motorola format)

• integer: 4Byte (4_3_2_1) for 4 byte integers in descendin
order (Intel format)

• float: 4Byte for 4 byte floating point numbers

• double: 8Byte for 8 byte floating point numbers.

Figure 5-5 The Import File dialog box.
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The data in the spectrum file must be a list of y values (no x 
ues). Therefore, information about the x values is also requi
You may enter this data in the Horizontal Values boxes. Often,
spectra have extra text at the beginning of the file such as
date, the name of the sample, or the operator. Header Size
allows you to enter the length of this text that precedes the ac
data of the spectrum.

Duplicate 5.3.3
Duplicate the active spectrum and parameter settings.
The Duplicate command creates a new spectrum window w
the spectrum and parameters of the currently active spect
window. The newly created spectrum window becomes 
active spectrum window.

Close 5.3.4
Close the active spectrum. The Close command closes the
active spectrum window. After clicking Close, the active win-
dow disappears. If the spectrum were not saved, the prog
prompts you with the following dialog box. Clicking on Yes
opens the Save As or Save dialog box. If you click No, the
spectrum disappears and all its information is lost. Cancel can-
cels the Close command.

Figure 5-6 The Save Changes dialog box.
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Save 5.3.5
Save the active simulated spectrum.  The Save command
saves the active spectrum to the hard disk or a diskette. 
command is used when you wish to save a spectrum that alr
has a filename. If the spectrum has no filename, the Save As
dialog box automatically appears. More details are given in 
description of Save As.

When spectra are saved, the spectrum as well as the simul
parameters are saved to disk.

Save As 5.3.6
Save the active simulated spectrum with a new name.
After you have simulated a spectrum, you may save it in a
directory. When you click Save As, a dialog box appears tha
lets you choose a filename, a destination directory, and a des
tion disk drive. The spectrum to be saved is the spectrum th
presently active. Each spectrum consists of a spectrum 
(*.spc filename extension) and a parameter file (*.par filename
extension). The default filename extension is *.par (for parame-
ter) and when a parameter file is saved, it saves the corresp
ing spectrum file as well. To select the appropriate disk dri
click on the arrow on the Drives: selector. To select the appro
priate directory or path, click on the appropriate paths in 
Directories: selector and click the appropriate drive icon. Th
spectrum filename is selected by clicking on the desired para
ter file or typing the filename in the File Name selector. Click-
ing OK saves the spectrum on the hard disk or diskette. Cancel
exits the dialog box without saving the spectrum.
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When spectra are saved, the spectrum as well as the simul
parameters are saved to disk.

If the chosen filename were already used by another file, a w
ing box gives you the opportunity to decide whether to replace
the existing file with the present spectrum. Pressing No cancels
the save process and you need to select another name or d
tory.

Figure 5-7 The File Save As dialog box.

Figure 5-8 Warning dialog box for overwriting files.
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Load Experiment Spectrum 5.3.7
Load an experimental spectrum to compare with the
simulated.  This command loads an experimental spectrum into
the program. The experimental spectrum is used to compare
simulated spectrum with actual experimental data. It open
dialog box identical to the Open dialog box.

Save Result Spectrum 5.3.8
Save the active result spectrum with a new name.  You
may add or subtract the simulated spectrum from the experim
tal spectrum to create a result spectrum. This command op
the Save As dialog box so that the result spectrum may 
saved.
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Print the active spectrum.  The Print command starts the
printing of the active spectrum. The Print Range should be left
at All. Print Quality should be set to the desired resolution. T
choices here depend on the type of printer attached to the c
puter. The desired number of copies may be entered into
Copies box. Clicking OK sends the data to the Windows Prin
Manager, where it is processed and sent to the printer. Cancel
exits the dialog box without printing a spectrum. Setup opens
the Printer Setup dialog box. If you wish to print the instrumen
parameters along with the spectrum, select Spectrum + Param-
eters. (See “Output Formatting” on page 5-18.)

Figure 5-9 The Print dialog box.
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Print Preview 5.3.10
Display full pages.  Print Preview shows how the active
spectrum would be actually printed on the installed printer.

In this mode, some new commands appear in the dialog b
Print opens the Print dialog box. Zoom In and Zoom Out allow
you to change the scale of the display: it does not affect the m
ner in which the spectrum is printed. The Close command
closes the window and returns you back to the application w
dow. The other commands are not active in this window.

Figure 5-10 The Print Preview dialog box.
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Print Setup 5.3.11
Change the printer and printing options.  It is possible to
have many different printers connected with many differe
setup options. Print Setup allows you to select the printer a
well as set it up with the required options. Select the appropr
printer by clicking on the appropriate printing device in th
Printer selector. Choose the orientation of the paper by click
on the desired option in the Orientation selector. The paper size
and the source of the paper are selected in the Paper selector.
Clicking the Options button opens a new dialog box. The co
tents of this dialog box is printer-dependent: consult your prin
documentation for further information. Clicking OK confirms
the current selection. Cancel exits the dialog box without mak-
ing the changes.

Figure 5-11 The Print Setup dialog box.
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Output Formatting 5.3.12
You may print spectra with or without the instrumental param
ters used for the simulation. The cascading menu Output For-
matting allows you to choose with the following options.

Spectrum Select the active spectrum. If you choose Spectrum, only
the spectrum is printed when you print a spectrum. 

Spectrum +
Parameters

Select the active spectrum and the acquisition param-
eters. If you choose Spectrum + Parameters, both the spec-
trum and the instrumental parameters are printed when you p
a spectrum.

Recent Files 5.3.13
The most recently used files are listed here. You may retri
these files easily by double-clicking the filename. This action
equivalent to using the Open command with the appropriate
filename.
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Exit 5.3.14
Quit the application; prompts to save spectra.  Clicking
on Exit finishes the WIN-EPR SimFonia session. If there were
any spectra that have not been saved, the application prom
you for each unsaved spectrum with a dialog box asking whe
you wish to save the spectrum. Clicking on Yes opens the Save
As dialog box to save that spectrum. No ends the session with-
out saving the spectrum. Cancel prevents the session from ter
minating. To exit the application, you may also use the Close
command in the system menu, double-click the upper left cor
of the window, or press Alt F4.

Figure 5-12 The Save Changes dialog box.
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The Parameter Menu 5.4

Solution 5.4.1
Simulate a solution spectrum.  Click on this option to simu-
late a solution spectrum. A checkmark on the left indicates that
is active. Note: only the Solution or Powder option (not both)
may be active at the same time.

Powder 5.4.2
Simulate a powder spe ctrum.  Click on this option to simu-
late a powder spectrum. A checkmark on the left indicates th
is active. Note: only the Solution or Powder option (not both)
may be active at the same time.

Figure 5-13 The Parameter drop-down menu.
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Experiment 5.4.3
Edit the Instruments Parameters. Selecting this command
opens a dialog box that allows you to enter the experime
parameters for a simulation.

Operator: Editing the name in the box enters a new operator name.

Date: This box indicates the date a simulation is performed.

Time: This box indicates the time a simulation is performed.

Comment: Editing the text in the box enters a new comment.

Automatic Field
Determination

Clicking this box performs an automatic calculation of the cen
field and sweep width to encompass the entire simulated s
trum. The center field and sweep width values displayed in 
window are disabled and the automatic values are used. This
culation is performed during the simulation, hence the cen
field and sweep width indicated on the page do not change until
after the simulation program has run. An x in the box indica
that this option is active. This box is grayed for a powder simu
tion and hence is only available for solution simulations.

Figure 5-14 The Instrument Parameter dialog box.
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Get Field /
Sweep

This button appears if there were an experimental spect
present. It allows you to choose a center field and sweep width
interactively for a simulation. Clicking on this button opens
new window with three markers (vertical lines) that move w
the cursor. The middle marker sets the center field and the o
markers set the sweep width. To set the center field, place
middle marker at the desired center field position. To set 
sweep width, click the left mouse button to activate the ou
markers. As you move the cursor, the outer markers move in
out symmetrically about the center field marker. To togg
between moving the center field and sweep width markers, click
the left mouse button. You may fix the positions of the mark
by clicking the right mouse button. Upon clicking OK, the cen-
ter field and sweep width are entered into the instrument par
eter window. If Cancel were clicked, you are returned to th
instrument parameter window with no changes made.

Figure 5-15 The Center Field and Sweep Width dialog box.
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To facilitate more precise positioning of the markers, you c
use the zooming and expansion features of this window.
zoom in on a particular area of the spectrum, click the Scaling
button. When this option is active, clicking the left mouse butt
toggles the cursor between the lower right and upper left co
of the zoom rectangle. As you move the cursor, the position
the rectangle corner moves with the cursor. Clicking with t
right mouse button expands the region encompassed by the 
angle to fill the whole window. This operation does not affect t
data itself: it simply changes the scaling and offsets of the dis-
play axes. Clicking the Reset button will return the display back
to its full range.

Clicking the *2 or /2 button decreases and increases the vert
display range by a factor of two. This corresponds to enlarg
or reducing the spectrum by a factor of two. Clicking th
Offset + or Offset - command shifts the spectrum upwards a
downwards. These operations do not affect the data itself: it s
ply changes the display of the data.

Center
Field

Editing the value in the box changes the value of the center fi
used in the simulation.

Sweep
Width

Editing the value in the box changes the value of the sw
width used in the simulation.

Resolution
in X

Clicking on the arrows with the left mouse button cycles the r
olution (the number of points) through the allowed values.

Signal
Channel

Clicking on this box implements instrument response functio
in the simulation. Magnetic field modulation amplitude and tim
constant distortions are included. If not selected, the signal ch
nel parameter other than the harmonic are ignored. An x in
box indicates that this option is active. This box is grayed fo
powder simulation and hence is only available for solution sim
lations.
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Modulation
Amplitude

Editing the value in this box changes the value of the magn
field modulation used in the simulation. This box is grayed fo
powder simulation and hence is only available for solution sim
lations.

Time
Constant

Clicking on the arrows with the left mouse button cycles t
time constant through the allowed values. This box is grayed
a powder simulation and hence is only available for solut
simulations.

Conversion
Time

Clicking on the arrows with the left mouse button cycles t
conversion time through the allowed values. This box is gra
for a powder simulation and hence is only available for solution
simulations.

MW
Frequency

Editing the value in the box enters the microwave frequen
used for the simulation in units of GHz.

Harmonic Clicking on the arrows with the left mouse button cycles the r
olution through the allowed values. 

Get Exp.
Parameters

This button appears if there were an experimental spect
present. Clicking on this button copies the instrument para
ters of the experimental spectrum to the simulation instrum
parameters.

Save as
Default

When clicked, this command saves the present experime
parameters as the default parameters. The next time a new 
trum window is created, it will use the default parameters.

OK This command returns you to the main application windo
when clicked.

Cancel This command returns you to the main application windo
when clicked. Any changes made to the parameters are canc
WIN-EPR SimFonia User’s Manual 5-24
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Hamiltonian (Solution) 5.4.4
Edit the hamiltonian parameters. Selecting this command
opens a dialog box in which you may enter the spin hamilton
parameters for a solution simulation. It appears only when 
have chosen the Solution option. The dialog box consists of two
areas, the Nucleus area and the Electron Area. The Nucleus
area is further split into two separate parts, the parameter list
the editor. The parameter list area displays the values to be use
in the simulation. There may be up to 20 different nuclei used
a simulation. If there were enough nuclei, a scroll bar appear
the right to allow you to scroll through the list. The editor area
used for entering and editing values that are to be inserted 
the parameter list. After values have been entered in the editor
area, they may be inserted into the parameter list by clicking
the Insert button. An entry in the parameter list may be edit
by double-clicking the desired entry in the list. The values th
appear in the editor. An entry in the parameter list may
deleted by clicking on the unwanted entry and clicking t
Delete button.

Figure 5-16 The Hamiltonian dialog box for solution simulations.

Parameter
List

Editor
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Element This box indicates the one- or two-letter element name co
sponding to the nucleus. You may enter it manually or by cho
ing an element by clicking the Get Element button.

# nuclei This box indicates the number of equivalent nuclei. It must
entered manually. Equivalent nuclei are nuclei that have ide
cal spin hamiltonian parameters such as the three protons
rapidly rotating methyl group.

Isotope This box indicates the isotope of the nucleus. You may ente
manually or by choosing an element by clicking the Get Ele-
ment button.

Spin This box indicates the spin of the isotope. It may be ente
manually or by choosing an element by clicking the Get Ele-
ment button.

Iso.
abd.

This box indicates the natural abundance of the isotope. 
may enter it manually or by choosing an element by clicking 
Get Element button. These values may be edited to account
isotopic enrichment or depletion. Take care that the sum of
abundances is equal to 100%.

g-Factor
(Nuclear)

This box indicates the nuclear g-value for the isotope. You m
enter it manually or by choosing an element by clicking the Get
Element button.
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A This box indicates the hyperfine coupling constant. Its va
may be entered manually or, if there were an experimental s
trum present, entered interactively by clicking the Exp button.
Clicking the Exp button opens a new window with two marke
(vertical lines) that move with the cursor. The marker that mo
with the cursor may be toggled by clicking the left mouse b
ton. The hyperfine coupling constant calculated (to first order
from the field separation of the markers and the electroni
-value is displayed next to Hyperfine Constant A:. The mark-
ers should be positioned on two adjacent EPR lines that are 
by the hyperfine interaction of the nucleus under questi
Clicking the right mouse button fixes the positions of the ma
ers. The OK command enters the hyperfine coupling constan
value into the hamiltonian window. If you click Cancel, you
return to the hamiltonian window with no changes made.

Figure 5-17 The Hyperfine Coupling Constant dialog box.
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To facilitate more precise positioning of the markers, you c
use the zooming and expansion features of this window.
zoom in on a particular area of the spectrum, click the Scaling
button. When this option is active, clicking the left mouse butt
toggles the cursor between the lower right and upper left co
of the zoom rectangle. As you move the cursor, the position
the rectangle corner moves with the cursor. Clicking with t
right mouse button expands the region encompassed by the 
angle to fill the whole window. This operation does not affect t
data itself: it simply changes the scaling and offsets of the dis-
play axes. Clicking the Reset button will return the display back
to its full range.

Clicking the *2 or /2 button decreases and increases the vert
display range by a factor of two. This corresponds to enlarg
or reducing the spectrum by a factor of two. Clicking the Offset
+ or Offset - command shifts the spectrum upwards and dow
wards. These operations do not affect the data itself: it sim
changes the display of the data.

The box next to A in the upper right-hand corner indicates th
units. Clicking on the arrow opens a drop-down menu in wh
you may choose the desired units by clicking on it. The selec
of units are:

• Gauss

• MHz

• 10-4 cm-1

Clear Clicking this button clears all the entries from the editor area.
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This button opens a window containing the periodic table and
spin values. You may select an element by clicking its box w
the left mouse button. The program then retrieves the d
regarding the element from the Bruker ENDOR tables. Click
on the arrow of the Nuclear Isotope box opens a drop-down
menu in which you may choose the isotope you wish to view
clicking on it. You may restrict the isotopes that are display
for the special cases of pure or radioactive elements by click
on the Show Pure Elements Only or Include Radioactive
Isotopes buttons. Clicking OK returns you to the hamiltonian
window with the isotopes, spins, natural abundances, a
nuclear g-values entered into the editor. Clicking Cancel returns
you to the hamiltonian window with no new entries in the edit

Figure 5-18 The Periodic Table dialog box.
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Insert Clicking this button inserts the contents of the editor area i
the parameter list.

Delete Clicking this button deletes the contents of the selected entr
the parameter list. An entry may be selected by clicking on
The entry is then highlighted.

g-Factor
(Electronic)

This box indicates the electronic g-value. Its value may be ed
or, if there were an experimental spectrum present, entered i
actively by clicking the Exp button. Clicking the Exp button
opens a new window with a marker (vertical line) that mov
with the cursor. The g-value calculated from the magnetic fi
position of the marker and the microwave frequency is display
next to Electron G-Factor. In order to determine the g-value
place the marker in the center of the EPR spectrum. Clicking
right mouse button fixes the positions of the marker. Clicki
OK enters the g-value into the hamiltonian window. Cancel
returns you to the hamiltonian window with no changes made

Figure 5-19 The g-value dialog box.
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To facilitate more precise positioning of the markers, you c
use the zooming and expansion features of this window.
zoom in on a particular area of the spectrum, click the Scaling
button. When this option is active, clicking the left mouse butt
toggles the cursor between the lower right and upper left co
of the zoom rectangle. As you move the cursor, the position
the rectangle corner moves with the cursor. Clicking with t
right mouse button expands the region encompassed by the 
angle to fill the whole window. This operation does not affect t
data itself: it simply changes the scaling and offsets of the dis-
play axes. Clicking the Reset button will return the display back
to its full range.

Clicking the *2 or /2 button decreases and increases the vert
display range by a factor of two. This corresponds to enlarg
or reducing the spectrum by a factor of two. Clicking th
Offset\ + or Offset - command shifts the spectrum upwards a
downwards. These operations do not affect the data itself: it s
ply changes the display of the data.

Third
Order

Clicking this box selects a third order perturbation theory cal
lation for the nuclei. If not selected, the splittings are trea
only to first order. An x in the box indicates that this option
active.

OK This command returns you to the main application windo
when clicked.

Cancel This command returns you to the main application windo
when clicked. Any changes made to the parameters are canc
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Edit the hamiltonian parameters. Selecting this command
opens a dialog box that allows you to enter the spin hamiltonian
parameters for a powder simulation. It appears only when 
have chosen the Powder option.

Units Clicking on the arrow opens a drop-down menu in which y
may choose the desired units by clicking on it. The selection
units are:

• Gauss

• MHz

• 10-4 cm-1 

Figure 5-20 The Hamiltonian dialog box for powder
simulations.
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A This column indicates the values of the nuclear hyperfine in
action matrix. Its values may be edited. It is assumed that
matrix is symmetric, therefore, only the upper part of the ma
is displayed.

P This column indicates the values of the nuclear quadrupole in
action matrix. Its values may be edited. It is assumed that
matrix is symmetric, therefore, only the upper part of the ma
is displayed.

g This column indicates the g values of the nuclear Zeeman in
action matrix. Its values may be edited. It is assumed that
matrix is symmetric, therefore, only the upper part of the ma
is displayed.

Second
Order

Clicking this box selects a second order perturbation theory 
culation for the nucleus. If not selected, the splitting is trea
only to first order. An x in the box indicates that this option
active.

# of
Nuclei

This box indicates the number of equivalent nuclei. You m
edit the value in the box. Equivalent nuclei are nuclei that h
identical spin hamiltonian parameters such as the three pro
of a rapidly rotating methyl group.

Spin
(Nuclear)

Clicking on the arrows with the left mouse button cycles t
nuclear spin through the allowed values. 

Scroll
Bar

The scroll bar on the left scrolls you through the different nuc
A maximum of 20 different nuclei is possible. 

g (Electronic) This column indicates the diagonal elements of the electron
matrix. It is assumed that all calculation are performed in a co
dinate system in which the electronic g matrix is diagonal.

Spin Clicking on the arrows with the left mouse button cycles t
electron spin through the allowed values. 
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D This box indicates the value of the zero field splitting parame
D. You may edit the value in the box. It is assumed that the p
cipal axes of the electron Zeeman and zero field interacti
coincide.

E This box indicates the value of the zero field splitting parame
E. You may edit the value in the box. It is assumed that the p
cipal axes of the electron Zeeman and zero field interacti
coincide.

Number
of Theta

This box indicates the number of theta angles to be used in t
powder average. You may edit the value in the box.

Number
of Phi

This box indicates the number of phi angles to be used in
powder average. You may edit the value in the box.

OK This command returns you to the main application windo
when clicked.

Cancel This command returns you to the main application windo
when clicked. Any changes made to the parameters are canc
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Shape (Solution) 5.4.6
Edit the Shape Parameters. Selecting this command open
a dialog box in which you may enter the parameters to determ
the lineshapes and linewidths used in a solution simulation.

Lorentzian/
Gaussian

Indicates the amount of lorentzian or gaussian contribution
the lineshape. Its value is editable. You may simulate linesha
that are a combination of both lorentzian and gaussian lines. 
amount of lorentzian or gaussian character equals 

(1-x) lorentzian + x gaussian. [5-1]

0 corresponds to a purely lorentzian lineshape. 1 correspond
a purely gaussian lineshape.

Linewidth Indicates the linewidth. You may edit the value in the box. T
linewidth is context-sensitive. For the zeroth harmonic, the line-
width is the full width at half height. For the first and secon
harmonics, linewidths are the peak-to-peak widths.

Figure 5-21 The Shape Parameters dialog box for
solution simulations.
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If anisotropy were not completely averaged out by rapid ro
tion, the linewidth may vary, depending on the hyperfine lin
Quite often, you can express the linewidths as a polynomia
mi. For example, the linewidth may be described as:

[5-2]

In these cases, SimFonia can simulate the mi linewidth depen-
dence if you supply the coefficients, a, b, and c. You may obta
these values interactively by using the calculate Constants
routine that fits the a, b, and c values by least squares.

Figure 5-22 Linewidth definitions.
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Clicking this box implements an mi dependent linewidth calcu-
lation. An x in the box indicates that the option is active. If 
valid nucleus were chosen, (i.e. no third order calculation, more
than one nucleus, spin less than 1), this box is grayed and h
is not available.

a: The constant linewidth term for mi dependent linewidths. You
may edit the value in the box.

b: The linear linewidth term for mi dependent linewidths. You may
edit the value in the box.

c: The quadratic linewidth term for mi dependent linewidths. You
may edit the value in the box.

Nucleus Indicates which nucleus is used to calculate the mi dependent
linewidth. You may edit the value in the box. It is assumed t
the nucleus has only one equivalent nucleus, that there is 
one isotope, the calculation is performed with third order pert
bation theory, and that the spin is greater than 1.
WIN-EPR SimFonia User’s Manual 5-37



The Parameter Menu

o
ths
ired

ers
the
sor
he
he
t-
ou
r
et
d.
ed

. If
calculate
Constants

Clicking this button opens up a new window that allows you t
enter the 2 * I + 1 (where I is the spin of the nucleus) linewid
necessary to fit a, b, and c. The number of linewidths requ
for the calculation is displayed next to # of areas to define.
The linewidths are selected by placing the right and left mark
(vertical lines) on the peak points of the EPR line to define 
peak-to-peak linewidth. The marker that moves with the cur
may be toggled by clicking the left mouse button. Clicking t
right mouse button fixes the positions of the markers. If t
Optimize Areas option is in effect (the default option), the sof
ware will search for the peaks in the vicinity of the markers. Y
still need to place the cursors as close as possible to the peaks fo
this option to work well. After the markers are fixed, a new s
will appear until all the required 2 * I + 1 linewidths are marke
The number of linewidths you have already defined is talli
next to areas defined. The OK command returns you to the
Shape dialog box and calculates a, b, and c automatically
you click Cancel, you return to the Shape dialog box with no
changes made.

Figure 5-23 The calculate Constants dialog box.
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To facilitate more precise positioning of the markers, you c
use the zooming and expansion features of this window.
zoom in on a particular area of the spectrum, click the Scaling
button. When this option is active, clicking the left mouse butt
toggles the cursor between the lower right and upper left co
of the zoom rectangle. As you move the cursor, the position
the rectangle corner moves with the cursor. Clicking with t
right mouse button expands the region encompassed by the 
angle to fill the whole window. This operation does not affect t
data itself: it simply changes the scaling and offsets of the dis-
play axes. Clicking the Reset button will return the display back
to its full range.

Clicking the *2 or /2 button decreases and increases the vert
display range by a factor of two. This corresponds to enlarg
or reducing the spectrum by a factor of two. Clicking th
Offset + or Offset - command shifts the spectrum upwards a
downwards. These operations do not a

OK This button returns you to the main application window wh
clicked.

Cancel This button returns you to the main application window wh
clicked. Any changes made to the parameters are canceled.
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Shape (Powder) 5.4.7
Edit the Shape Parameters. Selecting this command open
a dialog box in which you may enter the parameters to determ
the lineshapes and linewidths used in a powder simulation.

Lorentzian
/Gaussian

Indicates the amount of lorentzian or gaussian contribution
the lineshape. Its value is editable. You may simulate linesha
that are a combination of both lorentzian and gaussian lines. 
amount of lorentzian or gaussian character equals 

(1-x) lorentzian + x gaussian. [5-3]

0 corresponds to a purely lorentzian lineshape. 1 correspond
a purely gaussian lineshape.

Figure 5-24 The Shape Parameters dialog box for
powder simulations.
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Quite often, the linewidths can vary as a function of the direct
of the externally applied magnetic field.   For example, the lin
widths may be described as:

[5-4]

where lx, ly and lz are the direction cosines of the magnetic fie
on the electronic Zeeman principal axes and wx, wy, and wz are
the linewidths along the principal axes. In these cases, SimFonia
can simulate the orientational dependence of the linewidth.

Figure 5-25 Linewidth definitions.
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Linewidth
along x

Indicates the linewidth along the x axis. You may edit the va
in the box. The linewidth is context-sensitive. For the zeroth har-
monic, the linewidth is the full width at half height. For the fir
and second harmonics, linewidths are the peak-to-peak width

Linewidth
along y

Indicates the linewidth along the y axis. You may edit the va
in the box. The linewidth is context-sensitive. For the zeroth har-
monic, the linewidth is the full width at half height. For the fir
and second harmonics, linewidths are the peak-to-peak width

Linewidth
along z

Indicates the linewidth along the z axis. You may edit the va
in the box. The linewidth is context-sensitive. For the zeroth har-
monic, the linewidth is the full width at half height. For the fir
and second harmonics, linewidths are the peak-to-peak width

OK This command returns you to the main application windo
when clicked.

Cancel This command returns you to the main application windo
when clicked. Any changes made to the parameters are canc
WIN-EPR SimFonia User’s Manual 5-42
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The Operation Menu 5.5

Run Simulation 5.5.1
Start the simulation.  This command starts a simulation run
ning with the parameters of the active spectrum.

Algebra 5.5.2
Algebra with simulated and experimental spectra.  This
menu item will not be grayed if there is both a simulated a
experimental spectrum in the active window. Upon choosing 
option, the experimental and simulated spectrum will be d
played in a window with an Algebra Tool Bar along with the d
ference between the spectra (the result spectrum). 

Figure 5-26 The Operation drop-down menu.
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The result spectrum depends on the operation selected as w
the constants in the following manner,

Result = Experimental ⊗ Factor (Simulated + Constant) ,[5-5]

where ⊗ is an operation such as addition, multiplication, etc..

Algebra Tool Bar 5.5.3

The Algebra Tool Bar allows you to choose the operation a
well as adjust the Factor and Constant used in the calculation
of the Result spectrum. The left most buttons select the ope
tion when clicked. The available options are:

+ Clicking the Addition button adds the experimental and sim
lated spectra (along with factors and constants) and stores
sum in the result spectrum.

- Clicking the Subtraction button subtracts the experimental an
simulated spectra (along with factors and constants) and st
the difference in the result spectrum.

Figure 5-27 The Algebra Tool Bar.
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* Clicking the Multiplication button multiplies the experimenta
and simulated spectra (along with factors and constants) 
stores the product in the result spectrum.

/ Clicking the Division button divides the experimental spectru
by the simulated spectra (along with factors and constants) 
stores the quotient in the result spectrum.

The Factor and Constant in Equation [5-5] can be easily
adjusted by selecting one or the other in the drop-down list.
values are changed by moving the slider bar left and righ
decrease or increase the parameter value which is displayed
to the drop-down list. The sensitivity (the amount of change in
the parameter value per distance moved) of the slider ba
selected by clicking the /10 and *10 buttons and the sensitivity
is displayed between the two buttons.

You can also move the simulated spectrum right and left w
respect to the experimental spectrum by selecting either
X-Offset or X-Offset (Pt) in the drop-down list. The value in
the parameter value display has the units of the x-axis 
X-Offset and units of points or addresses for X-Offset (Pt).
Moving the slider bar left moves the spectrum left and rig
moves the spectrum right. The sensitivity (the amount of cha
in the parameter value per distance moved) of the slider ba
selected by clicking the /10 and *10 buttons and the sensitivity
is displayed between the two buttons.
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The Processing Menu 5.6

Multiply Factor 5.6.1
Multiply the active simulated spectrum with a factor.
Clicking the Multiply Factor command opens a dialog box i
which you may enter a multiplicative factor. When OK is
clicked, the entire active spectrum is multiplied by this consta
Cancel exits the dialog box without making the changes. Th
process actually changes the data of the active spectrum.

Figure 5-28 The Processing drop-down menu.
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Add Constant 5.6.2
Add a constant to the active simulated spectrum.
Clicking the Add Constant command opens a dialog box i
which you may enter an additive constant. When OK is clicked,
this constant is added to the entire active spectrum. Cancel exits
the dialog box without making the changes. This process a
ally changes the data of the active spectrum.

Differentiate 5.6.3
Differentiate the active simulated spectrum.  The Differ-
entiate command differentiates the complete active spectrum

Integrate 5.6.4
Integrate the active simulated spectrum.  The Integrate
command integrates the complete active spectrum.

Figure 5-29 The Multiply Factor dialog box.

Figure 5-30 The Add Constant dialog box.
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Offset Correction 5.6.5
Interactive Offset Correction of the active spectrum.
This command is used to subtract a baseline offset in a spect
The Offset Correction command draws a marker (horizonta
line) in the spectrum frame that represents the new level for z
signal. This line may be moved up and down by the mou
Position the line to coincide with the baseline of the spectrum.
Pressing the right mouse button sets the current line positio
the new zero for the vertical axis. This process actually chan
the data of the active spectrum. You may terminate the opera
by pressing Shift and ESC simultaneously.

Figure 5-31 The Offset Correction dialog box.
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Truncate 5.6.6
Truncate the active simulated spectrum.  Clicking the
Truncate command opens a dialog box in which you may e
the horizontal range of the active spectrum. The dialog box 
plays the starting and ending values of the active spectr
These parameters may be edited manually to any value, eve
new parameter were larger than the spectrum size. When OK is
clicked, the operation is performed. Cancel exits the dialog box
without making the changes. This process actually changes
data of the active spectrum.

Figure 5-32 The Truncate dialog box.
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The View Menu 5.7

Toolbar 5.7.1
Show or hide the toolbar.  Clicking on the Toolbar com-
mand toggles the option between showing or hiding the tool
A check mark on the left indicates that the toolbar is shown.

Info Line 5.7.2
Show or hide the info line.  Clicking on the Info Line com-
mand toggles the option between showing or hiding the in
line. A check mark on the left indicates that the info line
shown.

Figure 5-33 The View drop-down menu.
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Show or hide the display of cursor coordinates.  Click-
ing on the Coordinates command activates and deactivates t
display of the cursor’s current coordinates in the info line.
check mark on the left indicates that the coordinates are 
played.

Figure 5-34 The Cursor Coordinates display.

Cursor
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Zooming 5.7.4
Activate or deactivate the Rectangle Scaling Option.
Clicking on the Zooming command activates or deactivates th
rectangular scaling option. A check mark on the left indica
that zooming option is active. When this option is active, clic
ing the left mouse button toggles the cursor between the lo
right and upper left corner of the zoom rectangle. As you mo
the cursor, the position of the rectangle corner moves with 
cursor. Clicking with the right mouse button expands the reg
encompassed by the rectangle to fill the whole window. T
operation does not affect the data itself; it simply changes
scaling and offsets of the display axes. The display can be e
reset by clicking the right mouse button.

Figure 5-35 The zooming of spectra.
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Distance 5.7.5
Activate or deactivate the distance measurement.
Clicking on the Distance command activates and deactivate
the display of the distance between the cursors in the info line
check mark on the left indicates that the distance is display
When this option is active, two markers (vertical lines) appea
the center of the spectrum with the cursor at the leftmost ma
(the active marker). As you move the cursor, the info line d
plays the position of the active marker and the differen
between the active marker and the reference marker (the o
marker that is not moving). Clicking the left mouse button inter-
changes the reference and active marker. (Note that the differ-
ence becomes negative because the reference and active
been reversed.) Clicking the right mouse button deactivates
Distance option.

Figure 5-36 Distance measurement.

Distance
Display
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Scaling 5.7.6

The cascading menu Scaling offers the following options to
resize and shift the spectrum both vertically and horizontally.

Expand
Manual

Edit the display ranges of the active spectrum.  Clicking
on the Expand Manual command opens a dialog box in whic
you may edit the range of the active spectrum. The dialog 
displays the starting and ending values of the active spectrum as
well as the maximum and minimum intensities. You may e
these parameters to any value, even if a new parameter w
larger than the spectrum size. This operation does not affec
data itself; it simply changes the scaling and offsets of the dis-
play axes.

Figure 5-37 The Scaling cascading menu.
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Experiment /
Simulation

Identical Scaling for simulated and experimental spec-
trum.  If this option is selected, only the simulated and expe
mental spectra are scaled identically when any of the sca
commands in this section are used. Clicking on the Experimen-
tal / Simulation command toggles the option on and off. 
check mark on the left indicates that this option is in effect.

Result Scale the result spectrum.  If this option is selected, only the
result spectrum is scaled when any of the scaling command
this section are used. Clicking on the Result command toggles
the option on and off. A check mark on the left indicates that this
option is in effect.

All Identical Scaling for experimental, simulated and
result spectrum.  If this option is selected, all spectra ar
scaled identically when any of the scaling commands in this s
tion are used. Clicking on the All command toggles the option on
and off. A check mark on the left indicates that this option is
effect.

Figure 5-38 The Expand Manual dialog box.
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The View Menu

wo.
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wo.
. It

 the

ply

im-

is-
 the
ent
on.
Times 2 Decr ease display-range by 2.  Clicking the Times 2 com-
mand decreases the vertical display range by a factor of t
This corresponds to enlarging the spectrum by a factor of two
does not affect the data itself; it simply changes the scale of
vertical display axis.

Divide
by 2

Increase display-range by 2.  Clicking the Divide by 2
command increases the vertical display range by a factor of t
This corresponds to reducing the spectrum by a factor of two
does not affect the data itself; it simply changes the scale of
vertical display axis.

Offset
Plus

Shift view up.  Clicking the Offset plus command shifts the
spectrum upwards. It does not affect the data itself; it sim
changes the offset of the vertical display axis.

Offset
Minus

Shift view down. Clicking the Offset minus command shifts
the spectrum downwards. It does not affect the data itself; it s
ply changes the offset of the vertical display axis.

Reset Reset the display-scaling of the active spectrum.  Click-
ing the Reset command resets the scaling and offsets of the d
play axes. It does not affect the data itself; it simply changes
scaling and offsets of the display axes. A more conveni
means of resetting the display is to click the right mouse butt
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The View Menu
Display Mode 5.7.7

The cascading menu Display Mode offers the following options
to display the active spectrum.

Figure 5-39 The Display Mode cascading menu.
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The View Menu

ve
s is
the

ith
n

Line Standard display mode for the active spectrum. Click-
ing the Line command displays the data points of the acti
spectrum with dots that are connected by straight lines. Thi
the default setting. A check mark on the left indicates that 
Line option is in effect.

Point Displays only the spectrum points. Clicking the Point
command displays the data points of the active spectrum w
dots that are not connected by straight lines. A check mark o
the left indicates that the Point option is in effect.

Figure 5-40 A Line display.

Figure 5-41 A Point display.
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The View Menu

um
k

on-
hat
Cross Displays the spectrum points as crosses. Clicking the
Cross command displays the data points of the active spectr
with crosses that are not connected by straight lines. A chec
mark on the left indicates that the Cross option is in effect.

Line +
Cross

Displays the line-spectrum and marks the points as
crosses.  Clicking the Line + Cross command displays the
data points of the active spectrum with crosses that are c
nected by straight lines. A check mark on the left indicates t
the Line + Cross option is in effect.

Figure 5-42 A Cross display.

Figure 5-43 A Line + Cross display.
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The View Menu

ion
. A
Grid Switch the grid on and off. Clicking the Grid command tog-
gles the display of a grid on the active spectrum. This opt
may be useful for visually measuring and inspecting spectra
check mark on the left indicates that the Grid option is in effect.

Figure 5-44 A Grid display.
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The View Menu

ri-
the
i-
Show Experiment 5.7.8
Show or hide the experiment spectrum. Clicking the
Show Experiment command toggles the display of the expe
mental spectrum. A check mark on the left indicates that 
Show Experiment option is in effect. If there were no exper
mental spectrum loaded, the option will be grayed.

Figure 5-45 Display of both simulated and experimental
spectra.

Experimental
Spectrum

Simulated
Spectrum
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The View Menu

lt
per-
Show Operation Result 5.7.9
Show or hide the result spectrum. Clicking the Show
Operation Result command toggles the display of the resu
spectrum. The result spectrum is the result of the operations 
formed in the Algebra Tool Bar menu such as Addition or Sub-
traction. A check mark on the left indicates that this option is in
effect. If there were no experimental spectrum loaded, the option
will be grayed.

Figure 5-46 Display of all spectra.

Result
Spectrum

Experimental
Spectrum

Simulated
Spectrum
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The View Menu

e
ault
epa-

ate
 left
Overlay 5.7.10

Display experiment and simulation in overlay mode.
Clicking the Overlay command toggles the manner in which th
experimental and simulated spectrum is displayed. The def
means of presenting the two spectrum is both spectra well s
rated vertically as in Figure 5-45. The Overlay option presents
the two spectra on top of each other (or overlaid) to facilit
easier comparison of the two spectra. A check mark on the
indicates that the Overlay option is in effect. If there were no
experimental spectrum loaded, the option will be grayed.

Figure 5-47 An Overlay display.
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The Options Menu

ing
n. A

or
The Options Menu 5.8

Save Settings on Exit 5.8.1
Save settings on exit.  Clicking on the Save Settings on
Exit command toggles the option between saving or discard
the settings that have been used during the current sessio
checkmark on the left indicates that the settings will be saved.

Flickerfree Switch flickerfree display on or off. Clicking on the Flick-
erfree command toggles the option between a flickering 
smooth display while using the slider bar in the Algebra Tool
Bar. A checkmark on the left indicates flickerfree operation.

Figure 5-48 The Options drop-down menu.
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The Window Menu

The
 as
irst
bet-
The Window Menu 5.9

It is very easy to generate a large number of spectra quickly. 
spectrum windows can completely clutter your screen just
quickly. There are several ways to keep things neat. The f
approach is to cascade or tile the windows to organize them 
ter. A second means is to iconize spectra.

Figure 5-49 The Window drop-down menu.

Loaded
Spectrum
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The Window Menu

e all
Cascade 5.9.1
Arrange windows so they overlap.  The Cascade com-
mand stacks all the open windows such that their title bars ar
visible.

Figure 5-50 Cascaded spectra.
WIN-EPR SimFonia User’s Manual 5-66



The Window Menu

ot-
Tile Horizontal 5.9.2
Arrange windows as non-overlapping tiles.  The Tile
Horizontal command arranges all the open windows top to b
tom such that they are all visible.

Figure 5-51 Horizontal tiling.
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The Window Menu

ide
Tile Vertical 5.9.3
Arrange windows as non-overlapping tiles.  The Tile
Vertical command arranges all the open windows side by s
such that they are all visible.

Figure 5-52 Vertical tiling.
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The Window Menu

d)

e

he
the
Arrange Icons 5.9.4
Arrange icons at the bottom of the window.  The
Arrange Icons command evenly spaces the closed (minimize
windows at the bottom of the application window.

Loaded Spectra 5.9.5
Activate this window.  The names of the spectra which hav
been loaded are listed here. To activate a spectrum (i.e. make it
the active spectrum window), click the desired spectrum. T
active spectrum is indicated by a checkmark to the left of 
name of the spectrum.

Figure 5-53 Iconized spectra.
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Tool Bar

ss to
 the
Tool Bar 5.10

The tool bar contains icons that may be used for easy acce
frequently used commands. Clicking on the icon executes
command.

Figure 5-54 The Tool Bar.
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Print

Duplicate
Window

Save

Times 2

Solution /
Powder

Divide
by 2

Offset
Plus

Zooming

Run
Simulation
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Simulation

Shape

Offset
Minus

Instru-
ment

Hamiltonian
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Index
A
addition of a constant5-47

algebra 4-21, 5-43 to 5-45

- 5-44
* 5-45
+ 5-44
/ 5-45
constant 5-45
factor 5-45
tool bar 5-44
X-Offset 5-45
X-Offset (Pt) 5-45

application window. See window, applica-
tions.

arrange icons5-69

arrow box 5-6

automatic field determination5-21

C
cancel button 5-7

cascade 5-66

center field 5-23

check box 5-6

clear 5-28

close 5-11

commands 5-1 to 5-70

comment 5-21

comparing spectra4-20 to 4-23

control menu 5-3

conversion time 5-24

coordinates 5-51

Cr+3 in CsAl(SO4)2 . 12 H2O 4-29 to 4-36

linewidth dependence4-32
spin hamiltonian parameters4-31

D
date 5-21

deleting parameters5-30

dialog box 5-5 to 5-7

differentiation 5-47

display mode 5-57

cross 5-59
grid 5-60
line 5-58
line + cross 5-59
point 5-58

display range

decrease by 25-56
increase by 25-56

distance 5-53

drop-down selector5-6

duplicate 5-11

durosemiquinone radical anion4-2 to 4-23

E
editable box 5-5

editing experimental parameters4-7, 5-21
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Index
editing parameters. See menu, parameter.

element 5-26

Also see periodic table.

exiting the program5-19

expand manual5-54

exporting data 4-37 to 4-38

F
features 1-2

file menu. See menu, file.

finding things 2-1

flickerfree 5-64

Fremy salt in glycerol 4-24 to 4-28

comparison with experimental 
spectrum 4-28

g- and a- values4-25
mi linewidth dependence4-26 to 4-28

G
get element 4-15, 5-29

Also see periodic table.

get field/sweep 5-22

getting started2-1

g-factor

determination of the g-value4-8 to 4-11, 
5-30 to 5-31

electronic g-factor (solution)5-30
g-factor (nuclear) 5-26
g-matrix (electronic) 5-33

H
hamiltonian

powder 5-32
solution 5-25

harmonic 5-24

hyperfine

coupling (solution) 5-27
determining the hyperfine coupling 

constant 4-11 to 4-18, 5-27 to 
5-28

nuclear hyperfine matrix (powder)5-33
units 4-12, 5-28

I
importing files 5-10 to 5-11

ASCII files 5-10
binary files 5-10

info line 5-4, 5-50

inserting parameters5-30

installation of program2-2

integration 5-47

isotope 5-26

Also see periodic table.

isotopic abundance5-26

Also see periodic table.

L
line shape

durosemiquinone radical anion4-19
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Index
gaussian 5-35, 5-40
lorentzian 5-35, 5-40
powder 5-40
solution 5-35

linewidth

anisotropic 3-7, 4-32, 5-41
mi dependent 3-3 to 3-4, 4-24, 4-26 to 

4-28, 5-36 to 5-39
powder 5-42
solution 5-35

loaded spectra5-69

loading an experimental spectrum4-4 to 4-7, 
5-14

M
maximize 5-3

menu

bar 5-4
file 5-8 to 5-19
operation 5-43 to 5-45
options 5-64
parameter 5-20 to 5-42
processing 5-46 to 5-49
view 5-50 to 5-63
window 5-65 to 5-69

microwave frequency5-24

minimize 5-3

modulation amplitude5-24

multiplication 5-46

N
new 5-8

nuclear quadrupole interaction matrix 5-33

nuclear Zeeman interaction matrix5-33

number of nuclei

powder 5-33
solution 5-26

number of points 5-23

O
OK button 5-7

open 5-9

operation menu. See menu, operation.

operator 5-21

output format 5-18

overlay spectrum4-22, 5-63

P
periodic table 4-16, 5-29

perturbation theory

first order 3-3, 3-5, 3-6, 4-11
second order3-6, 5-33
third order 3-3, 3-5, 4-18, 4-26, 5-31

phi 3-8

number of angles4-35, 5-34

printing spectra 5-15

preview 5-16

processing menu. See menu, processing.
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Index
push button 5-6

R
recent files 5-18

reset 5-56

restore 5-3

run simulation 5-43

S
save 5-12

save as 5-12

saving

default parameters5-24
result spectra5-14
settings on exit 5-64

scaling 5-54

scroll bar 5-7, 5-33

selecting powder simulations5-20

selecting solution simulations5-20

setting up printers5-17

shift view

down 5-56
up 5-56

show

experimental spectrum5-61
result 5-62

signal channel5-23

spherical integration3-8, 4-33 to 4-36

spin

electronic 5-33
nuclear 5-26, 5-33

starting SimFonia2-4, 4-1

sweep width 5-23

system requirements2-2

T
theory

powder 3-5 to 3-8
solution 3-1 to 3-5

theta 3-8

number of angles4-35, 5-34

tile

horizontal 5-67
vertical 5-68

time 5-21

time constant 5-24

title bar 5-3

tool bar 5-4, 5-50, 5-70

truncate 5-49

tumbling effect 3-4, 5-37

See also linewidth, mi dependent.

tutorial 4-1 to 4-38

typographical conventions2-1

U
units 5-28, 5-32

using experimental parameters4-7, 5-24
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Index
V
view menu. See menu, view.

W
window

application 5-1 to 5-4
frame 5-4
spectrum 5-2

window menu. See menu, window.

Z
zero-field splitting 4-31, 5-34

zooming 5-52
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